Step 2: Headings and Subheadings

This PDF explains Step 2 of the step-by-step instructions that will help you correctly format your ETD to meet UCF formatting requirements.

Step 2 shows you how to set up heading styles. Heading styles allow you to format your headings and subheadings consistently throughout the document as a group without changing the formatting of each heading individually; heading styles allow you to change the formatting once then apply those format attributes (or look) to multiple headings and subheadings at one time.

Heading styles are extremely important, as they help Word index the location of each heading and subheading so you can later have Word automatically insert a table of contents of those headings and subheadings and also create the bookmarks when your file is converted to PDF format.

**IMPORTANT:** Before applying heading styles to your document, you will want to ensure that all of your major headings (e.g. Abstract, Acknowledgments, Table of Contents, chapter headings, etc.) are physically typed using the Caps Lock key. Do not change the font settings or the headings styles to be in “All Caps”. The reason for this is explained later in the Table of Contents instruction file.
**Identifying the Normal Style**

Whenever a new document (Word 2007 and newer) is opened, a set of visual attributes will already be built in. For example, there will be a default font style (Calibri), font size (11 points) and line spacing (1.15 spaces with an additional 10 points after each line).

This default template is called the **Normal** style.

The Normal style is automatically applied to everything in the document unless you change it. You can see the Normal style highlighted in yellow in the Styles pane:

To change the visual attributes of their document, people typically use the settings in the Home tab Font and Paragraph tool bars (as illustrated below) to reset their font style and size to a desired appearance, adjust the line spacing, and more:

However, this approach is not advisable for electronic thesis and dissertation formatting. It is best to change this default template rather than change your body text in a random way. Changing the Normal style will ensure consistency throughout your document and will enable much easier global document changes. Otherwise, Word can revert back to the default style at certain times and cause inconsistency if it does not look how you would like it to.

We will advise you on how to change the appearance of the headings and subheadings later in this document, but you first need to change the default, or Normal, style.

The Normal style should be applied to body text of your thesis or dissertation. If you already have body text in your document you have already changed the appearance for manually, you will still want to change the Normal style. You will just want to make sure your Normal style reflects the same attributes as the existing text (same font style, size, etc.).
Modifying the Normal Style

In the Home tab, you will see a section of the ribbon called “Styles.” In the lower right-hand corner of this section you will see a little diagonal arrow. Click on the arrow to bring up the Styles menu.

A menu containing a list of all of the styles in the document so far will appear on the right side of your document. The menu will look similar to the following image (your view may vary slightly):
Your first step will be to modify the Normal style.

- Find the style called Normal in the Styles task pane.

- Click the arrow button next to the word Normal (not the word itself) that appears when you mouse over it. This should bring up a drop-down menu:

  ![Menu](image1.png)

- Select Modify in this box. Another menu called “Modify Style” will pop up.

  ![Modify Style](image2.png)

This menu has all of the same buttons you usually find on the toolbar. This is where you can change the default font style, size, spacing and more for your entire document. Additional options are available under the “Format” button on the bottom left. Remember: all body text should be double spaced, so this is where you can make this change.

3/6/2012
About Heading Styles

As you learned in the Normal style instructions above, Word automatically has built in styles listed in the Styles menu. The Normal style is typically applied to the body text. However, this same style should not be used for your headings and subheadings. For these items, you will need to use “Heading” styles.

Word automatically creates Heading styles in the Styles menu. These are labeled as “Heading 1”, “Heading 2”, “Heading 3”, etc. Each time you apply a Heading style to a heading, Word will automatically create the next Heading style for you. For example, when you first apply Heading 1, Word will automatically add the Heading 2 style for you.

The following chart illustrates the styles you will be using and how they should be applied to each heading/subheading:

<table>
<thead>
<tr>
<th>Document Section</th>
<th>Heading Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Body Text</td>
<td>Normal style</td>
</tr>
<tr>
<td>Title page</td>
<td>Normal style, (manually change the line spacing for this text to single spacing and centered)</td>
</tr>
<tr>
<td>Copyright page</td>
<td>Normal style</td>
</tr>
<tr>
<td>Abstract</td>
<td>Precontent Heading style*</td>
</tr>
<tr>
<td>Dedication</td>
<td>Normal style</td>
</tr>
<tr>
<td>Acknowledgments</td>
<td>Precontent Heading style*</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Precontent Heading style*</td>
</tr>
<tr>
<td>List of Figures</td>
<td>Heading 1 style</td>
</tr>
<tr>
<td>List of Tables</td>
<td>Heading 1 style</td>
</tr>
<tr>
<td>List of Media/Abbreviations/</td>
<td>Heading 1 style</td>
</tr>
<tr>
<td>Nomenclature/Acronyms</td>
<td></td>
</tr>
<tr>
<td>Chapter Headings</td>
<td>Heading 1 style</td>
</tr>
<tr>
<td>First-level subheading</td>
<td>Heading 2 style</td>
</tr>
<tr>
<td>Second-level subheading</td>
<td>Heading 3 style</td>
</tr>
<tr>
<td>Third-level subheading</td>
<td>Heading 4 style</td>
</tr>
<tr>
<td>Fourth-level subheading</td>
<td>Heading 5 style</td>
</tr>
<tr>
<td>Appendices</td>
<td>Heading 1 style</td>
</tr>
<tr>
<td>References</td>
<td>Heading 1 style</td>
</tr>
</tbody>
</table>

*Note: you will not see the “Precontent” Heading style in the Styles menu, but these instructions will teach you how to add this style later.

IMPORTANT: Always use the existing Microsoft Word Heading styles. DO NOT change the name of the built in Heading styles. If you need to, make a separate list of what each Heading style means to you (e.g. Heading 1=APA chapter heading in another document or note.

Also: Ensure you have at least one hard return between your headings/subheadings and the following text (hit the enter key after typing the headings/subheadings). You want to ensure that your body text reverts back to the Normal style and does not take on the formatting of the heading style.

3/6/2012
Modifying Major Heading Styles

Just as we modified the Normal style for the body text, we now need to modify the Heading 1 style and apply this style to all of your major headings. Major headings include your chapter headings as well as your other major section headings including the Abstract, Acknowledgments, Table of Contents, List of Figures, List of Tables, Appendices, and References.

To modify Heading 1:

- Find the style called Heading 1 in the Styles task pane.

- Click the arrow button (not the words “Heading 1”) that appears when you mouse over it. This should bring up a drop-down menu:

  ![Styles Menu](image)

  - Select **Modify**. A small menu will pop up.

  This menu will have all of the same buttons you usually find on the toolbar. However, this menu will only allow you to change items that you have designated as Heading 1s.

  This is where you should change items like font size and type, single or double spacing, centering, bolding, etc.
To meet UCF formatting for major and chapter headings, you should modify the style to an easily readable font, like Times New Roman, font size 14, bold, centered, and single-spaced.
You will also need to change the spacing before and after the heading, as the default settings typically have too much extra space.

- Select the **Format** button in the lower left hand corner in the open “Modify Style” window for Heading 1

- Then select **Paragraph** from the drop menu that appears.
• A new window will appear labeled “Paragraph.”

- Where it says “Spacing,” make sure “Before” is set to “0 pt” and “After” is set to “24 pt”, which is equivalent to one extra double space (this will ensure that you always have consistent spacing between your headings and the following body text).

- Where it says “Line Spacing” make sure it is set to “Single”

- Click “OK” out of all the windows.

- Follow these same instructions to modify the spacing for the remainder heading and sub-heading styles.
Now you can apply the Heading 1 style to all of the major headings in the document.

- Place your cursor at the beginning of the heading (or highlight it) then click on Heading 1 in the Styles task pane.

- You should see your heading take on the attributes of Heading 1 you set up in the Styles menu (centered, bold, etc.)

- Apply the Heading 1 style to all of your major headings (see the chart on page 5 for list of headings that need this style).

After applying the style, the heading should look like this:

- You have successfully applied the Heading 1 style. If you need to make changes to any Heading 1 formatting, go back into the Styles task pane and make the change, repeating this process.
REMEMBER: DO NOT use the main Home tab toolbar functions to change the formatting of your headings! Instead, follow these same instructions and make the changes through the Modify menu.

Any changes made through the normal Word toolbar can inadvertently create extra styles and create extra (or missing) bookmarks in the final PDF document.

**Formatting Subheadings**

After the major and chapter headings are formatted with the Heading 1 style, you can format your subheadings.

As a reminder, you will be using Heading 2 for your first-level subheadings, Heading 3 for second-level subheadings and so on. As stated previously, the next Heading style will appear as soon as you use a level. Since you have already used Heading 1, Heading 2 should already appear in your Styles menu.

To modify Heading 2:

- Click the arrow button (not the words “Heading 2”) that appears when you mouse over it. This should bring up a drop-down menu.
The Modify Style box will appear:

![Modify Style dialog box](image)

You will make the changes to Heading 2 here the same way you modified Heading 1.

While the UCF Thesis and Dissertation manual offers some flexibility about subheading formatting (provided each level of subheading has a unique format), this explanation will use the base subheading examples in the TD manual. Also remember that subheadings should be in a 12-point font size.

For the purposes of this help file, Heading 2s will all be centered, underlined, and 12-point Times New Roman font.

- From the Modify Style menu, click on the Centered button, as well as the Underline button. The Preview section should reflect the changes.

- Hit **OK**.

- As before, you can now apply the style by placing your cursor at the beginning of the subheading (or highlighting it) and clicking on Heading 2 in the task pane.
Your first-level subheading has been modified. Repeat the same process to create each level of subheading using Heading 3, Heading 4, and so on.

All other subheadings should be modified the same way. Use the Styles menu to change heading styles to UCF and department standards.

**AGAIN**, be sure to use Modify Styles menu to adjust heading and subheading styles to meet UCF requirements. **DO NOT** use the main menu toolbar functions to change a subheading styles.
To Clear Formatting

When mistakes happen and you accidentally attribute a style to a section, you can clear the formatting to remove the style you applied. This most commonly occurs when a heading style accidentally gets applied to body text which should be in the Normal style.

- Highlight the portion of the document that needs clearing. At the very top of the task pane list of styles should be an option to “Clear All.”

- Click this.

- You can now apply the proper style needed.

Remember: DO NOT try highlighting the section and changing it manually using the main Word toolbar. This will only create additional styles.
**Precontent**

Once you finish setting up all of your headings and subheadings with styles, Word will be able to index those styles automatically into a Table of Contents. The next instruction file will explain how to do this.

However, before you have Word create your Table of Contents, some headings will need to be excluded from it. In order to do this, we need to set up a new style called “Precontent” that can be applied to the headings to be excluded.

Note: Some of the Precontent sections will have a heading style applied and some will not. You will not be applying the Precontent style to every section, but we will still refer to these sections as the Precontent.

Precontent sections are comprised of the following elements: title page, copyright page, Abstract, dedication page, Acknowledgments, and Table of Contents

**Bookmarks and Precontent**

Bookmarks are like a secondary Table of Contents residing in the left margin of a PDF document. Bookmarks are generated using the Word heading styles already applied to your headings and subheadings when you convert from Word to PDF format. You can see what the bookmarks menu looks like in the Sample ETD document, or by clicking on the bookmark icon to the left in this document.

Unlike the Table of Contents, which only displays the items appearing after the Table of Contents, the bookmarks menu should show ALL headings within your PDF file. However, if you apply the Heading 1 style to headings like ABSTRACT, ACKNOWLEDGMENTS and TABLE OF CONTENTS, these sections will appear in the bookmarks – AND when you generate a TABLE OF CONTENTS, which is not correct.

To give these headings the same formatting as other major headings and have them appear in the bookmarks, but not in the Table of Contents entries, you will need to create a new style called Precontent.

**PLEASE NOTE:** Before you work with Precontent headings, you will want to have already formatted other major section and chapter headings using the Heading 1 style; if you have not, please go back and review the other sections in this document before continuing here.

**Setting up the Precontent Heading Style**

In order to set up the Precontent Heading Style, you will have to use the Word Styles menu to create a new style based on Heading 1. We do this so the Precontent style will look like all of the other headings with the Heading 1 style, but we will later be able to exclude this style (and the headings formatted with it) from the Table of Contents.

In the Home tab, you will see a section of the ribbon called “Styles.” In the lower right-hand corner of this section you will see a little diagonal arrow. Click on the arrow to bring up the Styles menu.
You will see a list of all of the styles that have been used in the document so far.

Now find the section labeled “ABSTRACT” in the document.

- Place your cursor next to the word ABSTRACT, highlight the heading and ensure it is formatted with the Heading 1 style.

- You want to ensure this heading is in the Heading 1 style because you want Word to base the new Precontent heading style off of the Heading 1 style, but it won’t actually be a “Heading 1”.

- Click on the “New Style” button on the Styles menu (lower left corner). It will look like this:
This will bring up the New Style menu.

Since you clicked on Heading 1, the new style will reflect all of the same elements of a Heading 1: In our example, it is bold, 14 point, Times New Roman, and centered. You’ll need to give it another name to distinguish it from Heading 1s, so rename it Precontent.

- In the field next to Name, put “Precontent”

- Hit OK.

- Now go back, place your cursor next to the ABSTRACT heading (or highlight it), and click on Precontent in the styles list.

- You have now applied the Precontent style to the ABSTRACT heading
Precontent has now been added as a new Heading style. See the other instruction files to learn how to create the TABLE OF CONTENTS without including Precontent, but keep these headings in the bookmarks when converting to PDF.

The following sections illustrate how the Precontent sections should be formatted.

**Title Page (no heading style)**

UCF title pages follow a strict format for the text, as defined in the [TD Manual](#). You can format this text with the Normal style, but you will need to center all of the content on this page and change the line spacing to single spaced just using the regular Home tab tool bar.

For the title and your name, which should appear in ALL CAPS, simply type using the Caps Lock key. Do not apply the Precontent heading style to this page.
Copyright Page (no heading style)

Copyright information in the ETD should include the copyright symbol, the year of graduation and your name, as such:

©2012 Jane B. Doe

All copyright information should be centered on the page vertically and horizontally using the regular toolbar. Do not apply the Precontent heading style to this page.

ABSTRACT (Precontent heading style)

ABSTRACT is considered a major heading and should be formatted like all other major and chapter headings. However, simply applying the Heading 1 style will cause complications with the TABLE OF CONTENTS, so we will apply the Precontent style instead.

ABSTRACT body text should follow the same formatting as all other body text. Note that no figures, tables or inset quotes are allowed here.

Dedication (no heading style)

The dedication, if included, should be centered on the page vertically and horizontally. No heading style, including the Precontent style, should be used on this page.

ACKNOWLEDGMENTS (Precontent heading style)

ACKNOWLEDGMENTS is considered a major heading and should be formatted like all other major and chapter headings. However, simply applying the Heading 1 style will cause complications with the TABLE OF CONTENTS, so we will apply the Precontent style instead.

ACKNOWLEDGMENTS body text should follow the same formatting as all other body text.

TABLE OF CONTENTS (Precontent heading style)

The TABLE OF CONTENTS heading is considered a major heading and should be formatted like all other major and chapter headings. However, simply applying the Heading 1 style will cause complications with the TABLE OF CONTENTS, so we will apply the Precontent style instead.

Please see the TABLE OF CONTENTS instruction file to have Word automatically set up your Table of Contents.
You are now ready for

**Step 3: Table of Contents**

Questions?

Please contact the Editor
at [editor@ucf.edu](mailto:editor@ucf.edu)

OR

Submit your Microsoft Word file to the [Format Help](#) page of the [Thesis and Dissertation Services](#) site.